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History of change

1 History of change
Version Date Changes

2.0 11/06/2014 New Trace Guide document for GVS and
BLS uses.

2.01 12/11/2014 Updated formatting of Trace Guide document.

2.02 12/12/2014 Updated information about DUMP via Task
Manager.

2.03 22/12/2014 Review information about DUMP via Task
Manager for 32bit.

2.04 19/03/2015 Review information about TSP DUMP for 32
and 64 bit OS.

2.05 19/08/2015 Added information about Starting traces
automatically (via Diagnosis tool).

2.06 21/08/2015 Added information about detailed Audio logs.

2.07 25/09/2015 Review information about WinDbg DUMP and
url.

2.08 08/10/2016 Added information about Device audio
Log (Wav log) and contend review of other
chapters.

2.09 04/03/2016 Review and included new command about
TSP chapter 4.10.

2.10 20/05/2016 Review infos about Debug tools(Annex B
and C) and changed Unify address. Also
added details about how to fix TSP issues
preventing HFA to work ().

2.11 02/01/2017 Added tool to automatically collect infos
and print screens of test steps performed.
Chapter 4.17 about PSR.

2.12 18/01/2019 Changed new details about audio logs.
Chapter 4.15 & 4.16.

2.13 19/03/2019 Changed new details about audio logs.
Chapter 4.15 (HFA).

2.14 30/04/2021 Changed M5T details. Chapter 4.11.

2.15 05/10/2021 Added more info about M5T details. Chapter
4.11.

2.16 27/01/2023 General Review of complete trace. General
Specific Updated chapters 4 and review/
created chapter 5 (DUMPs).
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About this guide

2 About this guide
Generally, in case of issues related to clients (e.g. the clients stop working),
traces must be collected from customers to allow developers identify and
resolve errors.

The sooner the developers get the correct and precise traces, the better the
chances to find out the possible sources of errors to any given customer
problems.

It is important to allow technicians and sellers support to get the correct/precise
traces at the first visit at customer's site.

This guide provides useful information and hints about how to install correctly
the OpenScape Desktop Client (ODC) and get/extract the correct trace/
information depending of the provider used by the client (SIP or HFA
Stackless).
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Traces required
Using ODC with SIP Provider

3 Traces required

3.1 Using ODC with SIP Provider

If ODC is configured as SIP Provider, the following traces are required:

1) Open OptiClient GUI or OpenScape Desktop Client GUI.

NOTICE:  It is important to start all traces/logs (see 2.4)
BEFORE starting to use ODC-PE.

2) Locate the MSI trace file.
3) Locate the 2 Installation logs (generally stored in the %TEMP% folder).

The names of the logs include the version number.

Example:

For ODC-PE V7 R1.47.93, the 2 installation log files are:

• Unify OpenScape Client_70.1.47.0093_MSI.txt
• Unify OpenScape Client_70.1.47.0093_Setup.txt

4) Locate the ODC-PE Configuration files.
5) Analyse the network traffic on the PC where ODC is installed. You can

use Wireshark or any other network traffic analyzer.

This trace is needed in case of issues with payload/calls.
6) Take a note of the TIME when the error occurred (format hour: minutes).
7) Take a note of the LOGIN and PROFILE used when the error occurred.
8) A potential error cause is high use of PC processor. Therefore, make sure

to take a note of the following:

• Windows version used: e.g. Windows 10/11 (SP, last KB installed)
• The amount (%) of CPU used when the issue occurred.
• The amount of RAM memory used when the issue occurred.
• The amount of FREE RAM memory during ODC usage.

9) Describe how to reproduce the error in a step-by-step approach.

Example:

PartyA_Nr8900 calls PartyB_Nr8901 at 15:23hrs.

PartyB_Nr8901 hears the ring at 15:23hrs.

PartyB_Nr8901 accepts the ring at 15:24hrs.

… etc

Error: after X minutes/seconds the call is dropped at 15:26hrs.
10) Include screen shots or videos of the error if it is difficult to explain the

details.

It is recommended to collect screen shots or videos at full screen to better
present the steps, error and the time stamp of error.

11) Once all traces are collected, deactivate the traces.
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Traces required
Using ODC with HFA Provider (or HFA Stackless)

3.2 Using ODC with HFA Provider (or HFA Stackless)

If ODC is configured as HFA Provider, the following traces are required:

1) Open OptiClient GUI or OpenScape Desktop Client GUI.

NOTICE:  It is important to start all traces/logs (see 2.4)
BEFORE starting to use ODC-PE.

2) Locate the SCI trace file.
3) Locate the SoftOla trace file.
4) Locate the 2 Installation logs (generally stored in the %TEMP% folder).

The names of the logs include the version number.

Example:

For ODC-PE V7 R1.47.83, the 2 installation log files are:

• Unify OpenScape Client_70.1.47.0083_MSI.txt
• Unify OpenScape Client_70.1.47.0083_Setup.txt

5) Locate the ODC-PE Configuration files.
6) Analyse the network traffic on the PC where ODC is installed. You can

use Wireshark or any other network traffic analyzer.

This trace is needed in case of issues with payload/calls.
7) Take a note of the TIME when the error occurred (format hour: minutes).
8) Take a note of the LOGIN and PROFILE used when the error occurred.
9) A potential error cause is high use of PC processor. Therefore, make sure

to take a note of the following:

• Windows version used: e.g. Windows 10/11 (SP, last KB installed)
• The amount (%) of CPU used when the issue occurred.
• The amount of RAM memory used when the issue occurred.
• The amount of FREE RAM memory during ODC usage.

10) Describe how to reproduce the error in a step-by-step approach.

Example:

PartyA_Nr8900 calls PartyB_Nr8901 at 15:23hrs.

PartyB_Nr8901 hears the ring at 15:23hrs.

PartyB_Nr8901 accepts the ring at 15:24hrs.

… etc

Error: after X minutes/seconds the call is dropped at 15:26hrs.
11) Include screen shots or videos of the error if it is difficult to explain the

details.

It is recommended to collect screen shots or videos at full screen to better
present the steps, error and the time stamp of error.

12) Once all traces are collected, deactivate the traces.

3.3 Using ODC-WE (only for legacy)

If ODC-WE is used, the following traces are needed:
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• The traces described in Using ODC with SIP Provider on page 6 and
Using ODC with HFA Provider (or HFA Stackless) on page 7, depending
on the provider type.

• WebClient local traces (see 2.4).
• WebClient server traces.

For more information about WebClient local and traces WebClient server
traces, see:

http://gvs-ftp.cycos.com/tiki-index.php?page=gvs_tiki_know_Webclient_core

For more detailed WebClient traces, including DEBUG and TRACE messages,
the value of the LOG_INIT_LEVEL4J and LOG_INIT_LEVEL variables need to
be set to 5 in the global.cfg file:

/opt/siemens/HiPathCA/config/common/global.cfg
# Log size depending on 8k scenario
<?x if(<?x $IS_HP8K ?> == "1") ?>
<?x setvar (LOG_INIT_LEVEL4J = "5" ) ?>
<?x setvar (LOG_INIT_LEVEL = "5" ) ?>
<?x setvar (LOG_INIT_MAXDAYS = "3" ) ?>
<?x setvar (LOG_INIT_MAXFILESPERDAY = "15" ) ?>
<?x else ?><?x setvar (LOG_INIT_LEVEL4J = "5" ) ?>
<?x setvar (LOG_INIT_LEVEL = "5" ) ?>
<?x setvar (LOG_INIT_MAXDAYS = "5" ) ?>
<?x setvar (LOG_INIT_MAXFILESPERDAY = "30" ) ?>
<?x endif ?>

To apply these changes, you need to restart the WebClient components
(WebClient_FE & WebClient_BE).

WebClient traces that show the most important information are marked as P[sS]
[mM]*.

The most important files to be reviewed within development are located in the
following path /var/siemens/common/log/webclient/<date>/P[sS]
[mM]*:

• PsmApplicationService-*.log

• PSMService-*.log

In /opt/siemens/HiPathCA/config/services/default/PSMService/PSM.cfg you
might also want to activate CSTA tracing by activating, if there are call flow
errors.

In case of call flow errors, you can also activate CSTA tracing using the
following path /opt/siemens/HiPathCA/config/services/default/
PSMService/PSM.cfg.

Example:

CSTA.traceSubDir = csta

NOTICE:

It is recommended to attach the entire WebClient log folder.
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Activating Client Traces via Diagnosis Tool

Client-side traces

For issues related to non-responsive WebClient, additional browser side
traces need to be provided. For this, set :trace=on in the "< Name or
Number >" input file of WebClient UI.

Once the trace parameter is set to on, a pop-up window with the trace log is
displayed. When an issue occurs, copy the content of the trace log and paste
it into a text file. After capturing the trace log, close the pop-up window and set
:trace=off in the "< Name or Number >" input file of WebClient UI.

3.4 Activating Client Traces via Diagnosis Tool

You can use the OpenScapeClientDiagnosis.exe tool to activate or deactivate
specific traces from Clients (e.g. ODC-PE or ODC-WE), such as:

• OC traces
• MSI traces
• SCI traces
• SoftOla traces

You can securely collect all Client traces and additional system details via a
button displayed in the tool.

The Diagnosis tool is installed within the same base folder as the ODC-PE /
WE, inside Tools subfolder.

3.4.1 Starting Diagnosis Tool

The Diagnosis tool is located in the following path:

C:\Program Files (x86)\Unify\OpenScape Desktop Client
\Tools:

To start the Diagnosis tool, run the OpenScapeClientDiagnosis.exe file.

Figure 1: Starting the Diagnosis tool

NOTICE:  If your operating system is Windows 32bit, the
Diagnosis tool will be located in the following path:
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C:\Program Files\Unify\OpenScape Desktop Client
\Tools

3.4.2 Configuring Traces

By default, the Traces are stopped on the Diagnosis tool.

Figure 2: Configuring traces

To start or stop collecting traces with the Diagnosis tool, click the Trace button:

• When the button displays Trace is Off, traces are stopped.
• When the button displays Trace is On, traces are started.

You can configure the traces you want to collect, using the following steps:

1) Navigating to the Advanced tab.
2) Select the traces you want to collect in the Trace settings area.

Figure 3: Configuring the traces

You can change the path where traces are stored, using the following steps:

1) Click Change Folder and select the path where you want to store traces.
2) Click Trace is On to start collecting traces.
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Traces required

3) Restart the tool for changes to take effect.

Figure 4: Changing the traces folder

3.4.3 Collecting Traces

When an error occurs, close the client and open the Diagnosis tool. Click
Collect Diagnosis Data to start collecting trace logs.

Figure 5: Collecting all client traces

A now window displays, asking you to select a location to store the traces. The
traces will be available in the selected path as a ZIP file.
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Figure 6: Configuring the traces

NOTICE:  It might take a few minutes until all traces are
collected and the ZIP file is generated.

Figure 7: Diagnosis Tool generating the ZIP file with traces

After all traces are collected and the ZIP file is generated, a
message is displayed in the Diagnosis tool.

Figure 8: Successful message for collecting and zipping
traces
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Traces required
Regedit file Settings

3.4.4 Disabling Traces

It is recommended to disable the traces from the Diagnosis tool, after you finish
collecting them.

To disable traces, click Trace is On and restart the Diagnosis tool for the
changes to take effect.

Figure 9: Disabling traces

3.5 Regedit file Settings

Generally, all OpenScape Desktop Client traces (OC, MSI, SCI and  SoftOla)
must be activated or deactivates via the Diagnosis tool. For more information,
see Activating Client Traces via Diagnosis Tool on page 9.

There are specific cases when traces must to activated or deactivated manually,
via a regedit file.

Regedit files provide a secure and consistent way to configure trace settings.
Using regedit files, you can collect all necessary traces and speed up the
(de)activation of traces.

Examples of using regedit files:

Traces for SIP Provider

64 bits

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Siemens\OpenScape
\Trace]
"WriteToFile"=dword:00000001
"MSITrace"=dword:00000001
"PathFile"="c:\\traces\\"
"MSItraceFile"="c:\\traces\\msi.trc"

32 bits

[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\OpenScape\Trace]

A31003-G2570-M100-02-76A9, 09/2024
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"WriteToFile"=dword:00000001
"MSITrace"=dword:00000001
"PathFile"="c:\\traces\\"
"MSItraceFile"="c:\\traces\\msi.trc"

Traces for HFA Stackless Provider

64 bits

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Siemens\OpenScape
\Trace]
"WriteToFile"=dword:00000001
"PathFile"="c:\\traces\\"
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Siemens\SoftOLA
\Trace]
"WriteToFile"=dword:00000001
"PathFile"="c:\\traces\\"
"SciTrace"=dword:00000001
"SciPathFile"="c:\\traces\\sci.trc"

32 bits

[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\OpenScape\Trace]
"WriteToFile"=dword:00000001
"PathFile"="c:\\traces\\"
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\SoftOla\Trace]
"SciTrace"=dword:00000001
"WriteToFile"=dword:00000001
"PathFile"="c:\\traces\\"
"SciPathFile"="c:\\traces\\sci.trc"

3.6 Quick Review and Planning

When reviewing traces, the technicians and support teams analyze the
following:

• The client used by the customer (ODC-PE version)
• The Provider type used (SIP or HFA Stackless)
• In crash or freeze scenarios, the DUMP 32 bit trace must be provided.

You can use one of the following tools to collect DUMP 32 bit logs:

– Windows TaskManager 32 bit
– ADPlus
– Windbg, when it is not possible to use TaskManager 32 bit or ADPlus

E.g. if the software does not crash but it freezes or when it crashes during
the start of the client.

• For issues related to communication or networking, you must also provide
WireShark traces.

• The detailed description of the issue, with a step by step approach and
the timestamp of the error.

This allows GVS or Development teams to reproduce the error in the lab.
• Print screens and/or Video (in FULLSCREEN) to provide a better overview

of the issue.
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Summary of traces

After analysing information provided, further details or traces might be
requested by the support teams.

3.7 Summary of traces

For new Customer Tickets (PRB), the following traces must be provided:

Traces Names / types ODC-PE

HFA
Stackless

ODC-PE

SIP

ODC-PE

HFA H323 *

GUI / Pearl Trace

(OC….trc)

Yes Yes Yes

Softola Trace Yes Yes

SCI trace Yes Yes

MSI trace Yes

DUMP 32 bit ( if crash/
freeze )

Yes Yes Yes

Audio Device (WAV log) D D D

MS PerfMon log D D D

Installation log Yes Yes Yes

Configuration files Yes Yes Yes

Wireshark Trace Yes Yes Yes

TSP Trace D D

M5T trace D

RV Trace D D

Yes: mandatory to be attached

D: only requested on specific development requests

*: HFA H323 it is NOT supported anymore.

3.8 Trace description

This chapter describes how to activate different traces and trace levels for
OpenScape Desktop Client. You can create or activate the following traces,
depending on the errors found:

• optiClient GUI or OpenScape Desktop Client GUI trace contains:

The trace of the user interface / GUI / Pearl.

The trace of the SIP Engine.
• Softola trace contains:

The trace of the communication between OpenScape Desktop Client and the
communication system, the configuration and control of the SCI.
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• SCI trace contains:

The trace of the negotiation of the codecs.

The control of the media stream between HiPath HFAand the soundcard.
• MSI trace contains:

The trace of the negotiation of the codecs

The control of the media stream between HiPath SIP and the soundcard.
• RAD vision trace contains:

The trace of the H323connection.
• M5T trace contains:

Traces of the M5T component (responsible for the SIP engine, at a lower
level).

• TSP trace contains:

Traces from communication features call control between SoftOLA and the
PBX system.

• WebClient trace contains:

Local traces of the webclient.
• DLS traces contains:

Traces of the communication between ODC and DLS.
• DUMP 32 bit contains:

DUMP traces in 32 bit format, collected during the ODC crash.

This type of trace can be collected via on of the following tools: Windows
TaskManager (32 bit variation), WinDbg, ADPlus.

• Advanced Audio logs
• Audio Device log (Mic wave)
• MS Performance Monitor
• PSR tool
• Wireshark traces

Specific log for problems related to networking, lost of packages, VPN,
server issues (Citrix, etc). Traces should be collected via Wiresbhark or a
similar tool.

3.9 Activating Traces/DUMPs

3.9.1 Activating OC/GUI – Trace

To activate the OC/GUI-Trace, you must create the following Registry – Key:

• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\OpenScape\Trace]

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\OpenScape\Trace]
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Advanced options

• Write trace to file

Create the following registry value in the Trace key:

"WriteToFile"
DWORD 1 = On, 0 = Off

• Pathfile

Create the following registry value in the Trace key:

"PathFile"
STRING example: “C:\TEMP\”

When you start a trace, a new file is created in the C:\TEMP folder. If you
write a full path with a file name (e.g. “ C:\TEMP\Tracefile.trc), all traces will
be appended in the given file.

– PS1: If the value PathFile is missing, trace files will be created under
“Own Files” every time a trace is started, with a new file name.

– PS2: The path used must exist on the system.
• Free space

Create the following registry value in the Trace key:

"FreeDriveSpacePerCent"
DWORD 0-99

Tracing is stopped if the there is no free space on the drive.
• Last date

Create the following registry value in the Trace key:

"LastTraceDateTime"
STRING “200112201350”

Tracing is stopped at 20.12.2001 13:50.
• Max File Size

Create the following registry value in the Trace key:

"MaxFileSize"
DWORD x Bytes

Tracing is stopped if the trace file has reached the given size (x Bytes).
• Files

Create the following registry value in the Trace key:

"Files"
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DWORD 0-99

The tracing uses a circular buffer. This registry value is in correlation with
MaxFileSize. If the value defined for the number of files is greater than 0,
“~xx” will be added to the name of the trace files.

If a trace file reaches the size defined by MaxFileSize, a new file is created
(with the next number) until the number defined by “Files” is reached. Then,
the tracing will be written in the first file “~01”.

If the PathFile value is similar to C:\TEMP\, then every trace that starts will
create a new packet of files.

• Delete older trace files, when using the Files key

Create the following registry value in the Trace key:

"DeleteXDaysOldFiles"
DWORD xx Days

If you use the registry values Files and PathFile with a path similar to C:
\TEMP\, then every trace that starts will create a new packet of files.

To delete the older file packages on trace start, you can use this registry
value. For this, enter the desired value:

e.g. To delete all file packages older than one week (7 days), use value 7.

3.9.2 Activating Softola – Trace

To activate the Softola-Trace, you must create the following Registry – Key:

• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\SoftOla\Trace] 

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\SoftOla\Trace]

Advanced options

• Tracelevel

Create the following registry value in the Trace key:

"TraceLevel"
DWORD 9

• Write trace to file

Create the following registry value in the Trace key:

"WriteToFile"
DWORD 1 = On, 0 = Off

• Pathfile

Create the following registry value in the Trace key:

"PathFile"
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STRING example: “C:\TEMP\”

When you start a trace, a new file is created in the C:\TEMP folder. If you
write a full path with a file name (e.g. “ C:\TEMP\Tracefile.trc), all traces will
be appended in the given file.

– PS1: If the value PathFile is missing, trace files will be created under
“Own Files” every time a trace is started, with a new file name.

– PS2: The path used must exist on the system.
• Free space

Create the following registry value in the Trace key:

"FreeDriveSpacePerCent"
DWORD 0-99

Tracing is stopped if the there is no free space on the drive.
• Last date

Create the following registry value in the Trace key:

"LastTraceDateTime"
STRING “200112201350”

Tracing is stopped at 20.12.2001 13:50.
• Max File Size

Create the following registry value in the Trace key:

"MaxFileSize"
DWORD x Bytes

Tracing is stopped if the trace file has reached the given size (x Bytes).
• Files

Create the following registry value in the Trace key:

"Files"
DWORD 0-99

The tracing uses a circular buffer. This registry value is in correlation with
MaxFileSize. If the value defined for the number of files is greater than 0,
“~xx” will be added to the name of the trace files.

If a trace file reaches the size defined by MaxFileSize, a new file is created
(with the next number) until the number defined by “Files” is reached. Then,
the tracing will be written in the first file “~01”.

If the PathFile value is similar to C:\TEMP\, then every trace that starts will
create a new packet of files.

• Delete older trace files, when using the Files key

Create the following registry value in the Trace key:

"DeleteXDaysOldFiles"
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DWORD xx Days

If you use the registry values Files and PathFile with a path similar to C:
\TEMP\, then every trace that starts will create a new packet of files.

To delete the older file packages on trace start, you can use this registry
value. For this, enter the desired value:

e.g. To delete all file packages older than one week (7 days), use value 7.

3.9.3 Activating SCI – Trace

To activate the SCI-Trace, you must set/create the following Registry – Value:

• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\SoftOla\Trace]

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\SoftOla\Trace]

This will create a trace file in the temp folder with the name
sciyyyymmddhhmmss.trace.log, where yyyymmddhhmmss is the date an
time when the tracing starts.

The location of the temp folder depends on the setup of the TEMP environment
variable. Typically, the temp folder is located at: %temp%.

The tracing stops automatically when the drive space is less than 5%.

When the trace file is created and there are more than 10 old tracefiles in the
temp folder, the oldestfile will be deleted.

3.9.4 Activating MSI – Trace

To activate the MSI-Trace, you must set/create the following Registry – Value:

• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\OpenScape\Trace]

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\OpenScape\Trace]

This will create a trace file in the temp folder with the name
MSITraceyyyymmddhhmmss.txt, where yyyymmddhhmmss is the date an
time when the tracing starts.

The location of the temp folder depends on the setup of the TEMP environment
variable. Typically, the temp folder is located at: %temp%.

It is possible to configure the path and file name of the trace file via the following
registry key:

“MSITraceFile” STRING

• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\OpenScape\Trace]

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\OpenScape\Trace]

This parameter must contain a valid path and file name, similar to C:\temp
\msi.txt.
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If the path and file name are configured, the date and time will be added to the
file name: e.g. C:\temp\msiyyyymmddhhmmss.txt.

When the trace file is created and there are more than 10 old tracefiles in the
temp folder, the oldestfile will be deleted.

3.9.5 OpenScape Desktop Client - Installation log files

During the installation of the client, the following log files are created in the
following %temp% folder:

Siemens OpenScape Desktop Client_”versionnumber”_MSI.txt
Siemens OpenScape Desktop Client_”versionnumber”_Setup.txt

3.9.6 OpenScape Desktop Client - Installation log files

The client configuration files are stored in XML format.

NOTICE:  All files in the configuration files must be archived and
attached to the corresponding ticket.

The default folder with the OpenScape Desktop Client configuration is located in
the following path:

%appdata%\Unify\OpenScape (or %appdata%\Siemens\OpenScape for
older versions).

If the path has changed, you can use the
Unify.OptiClient.SettingsFoldersTool.exe tool to identify the new location.
This tool available under:

• For a 32-bit system:
%programfiles%\Unify\OpenScape Desktop Client\Client

• For a 64-bit system:
%programfiles(x86)%\Unify\OpenScape Desktop Client\Client

If the path did not change, the fields displayed in the tool are empty.

Figure 10: Viewing the configuration path
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3.9.7 TSP Trace

In case of TSP Trace, you need to first determine the TSP version running on
your computer.

Use the following command to determine to identify the TSP version:

C:\WINDOWS\system32>wmic product 
where"Name like '%Unify TSP%'" get Name, Version,
 IdentifyingNumber

Example results:

IdentifyingNumber: {C3C1BF22-F499-4DB3-874B-EB792EE63C9E}

Name: Unify TSP x64

Version: 1.0.0

To collect TSP traces, follow the steps below:

1) Download or install the Microsoft tools used for collecting traces (Dbgview or
Windbg).

2) Activate the traces via regedit (based on the PBX used, regardless of the
OS).

3) Collect the traces after the tests are performed

3.9.7.1 Activating the trace

To collect TSP traces (as 4.10.2), you need to activate the TSP trace first.

You must create the traces for OpenScape Business (OSBiz) and OpenScape
4000 (OS4K) separately:

• For OSBiz (or H3K, OSO, or any other PBX except for theHP4K family):

Set/create the Registry – Value:
DBGTrace"= dword:00000001

in the registry key:

[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\optiClientTSP Hicom
 150\Trace]

If requested by GVS or Development teams, add the following registry value
DBGTraceEnh"= dword:00000001 in the same registry key.

• For H4K:

Set/create the Registry – Value:
DBGTrace"=dword:00000001 

in the registry key:

[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\optiClientTSP
 HiPath 4000 V2\Trace]

If requested by GVS or Development teams, add the following registry value
DBGTraceEnh"= dword:00000001 in the same registry key.
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NOTICE:  To activate the trace, you must restart the telephony
service (or, if it is not possible, restart the pc) .

NOTICE:  Such activation must be done for all OS and all types
of PBX.

3.9.7.2 Collecting the trace

Regardless of OS and PBX, it is necessary to use a compatible tool (e.g.
Dbgview or Windbg) to collect the TSP trace activated before via regedit.

Windows XP

If the OS is Windows XP, you must first start the Dbgview tool to collect the
trace, before starting the Client. Once the test is completed, save the file.

Windows 7 and Higher

If the OS is Windows 7 or higher, the process you need to follow to collect the
trace is more complex. The svchost process which is the parent process of
telephony service should be attached to the Windbg tool. To do so, follow the
steps below:

1) Start WinDbg.
2) Attach the svchost process that has the telephony service under it.
3) In the command line of WinDbg, run the sxe * command, then the g

command.
4) Execute the test.
5) In WinDbg, break the running process.
6) Save the file from WinDbg.
7) Deattach the process from WinDbg.

For more information, please refer to Annex C.

3.9.7.3 Fixing TSP issues after install

Regardless of ODC-PE version installed, TSP issues might occur due to
wrongly deleted regedit keys during the optimization of the regedit tool and/or
the uninstall/setup of other programs.

PE HFA displays error messages in case of corrupted/incompleteTSP
installation.

Example:

• "TAPI Provider can not be found "
• “HiPath-Provider 5.1 is not connected ”.

Example: error 1

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion
\Telephony\Providers
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Figure 11: Example of problematic regedit (missing the main 3 provider’s
details)

Example: error 2

Several issues can be identified via the Phone & Modem Windows module.

If the ODC-PE providers are missing, then the setup is not correct.

Figure 12: Example of problem confirmation via “Phone and Modem”
module.

If the provider does not exist or it is empty, then you can only fix this issue
manually via regedit.

First, you must check if the issues are similar to the previous ones. To check
this, see above errors with Customer’s regedit keys (if it exists) and if it has
contents.

If the problem is the same as a previous one, follow the steps below
(administrator privileges are mandatory):

1) Close ODC-PE.
2) Stop the Telephony service.
3) The registry key is created:

"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Telephony\Providers"
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4) The contents of the registry key:
"HKEY_LOCAL_MACHINE\SOFTWARE\ Wow6432Node \Microsoft\Windows\CurrentVersion
\Telephony\Providers" 

are copied to the registry key:
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Telephony\Providers"

Example of a normal/clean Wow6432Node regedit:

Figure 13: Example of normal/Clean Wow6432Node regedit (for be used
to edit the 64-bit key) .

5) Start the Telephony service.
6) The "TSPx64" installation is repaired. If the repair does not add the ODC's

TSP providers, the TSP must be uninstalled and then installed again.
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7) Start ODC-PE.

Example after the issues with regedit are fixed:

Figure 14: Example of a fixed 64-bit regedit key

Example after the issues with Windows Phone and Modem module are
fixed:

Figure 15: Example of a “Phone & Modem” module fixed

3.9.7.4 Activating M5T Trace

To activate the M5T-Trace, you must set/create the following Registry – Value
“m5tdebugtrace"=dword:00000001

• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\Sipengine]

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\Sipengine]
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Additional details:

The Sipengine key will not be automatically created. It must be manually
created by the user or admin:

1) With the “Siemens” key selected, right-click and select “New => Key ”.
2) Rename it to “SipEngine”.
3) Inside it, create the DWORD“m5tdebugtrace" with the value 00000001.

Hints

If the system becomes very slow (that prevents or makes it difficult to perform
the tests), collect the logs using the following method:

IMPORTANT:  This method is only recommended if the system/
PC becomes slow.

By default, once the key with value = 00000001 is created, the information will
be logged in the Gui-Trace. However, it is possible to configure the path and file
name of the trace file:

To set the path and file name, use the registry key stacktracepath (key type:
REG_SZ or String).

Example:

stacktracepath=c:\traces\M5Ttrace.txt

• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\Sipengine]

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\Sipengine]

The parameter must be a valid path and file name, as for example: c:\traces
\M5Ttrace.txt

NOTICE:

The file (mentioned via stacktracepath) will be overwriting
every time ODC starts.

NOTICE:

When the stacktracepath registry key is created, the M5T logs
will be stored in the following two locations: the GUI-Trace and
the file specified by the stacktracepath key.

Therefore, for systems that become very slow, set a valid path to the
stacktracepath key and the value 0x0 for the m5tdebugtrace key.

With such configuration, the M5T information will be stored only in the file
specified by stacktracepath (and not in the GUI-Trace, making the system be
less slow).

Disabling the M5T-Trace

To disable the trace, you must set the following Registry - Value:
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“m5tdebugtrace"=dword:00000000

NOTICE:  Setting this key to 0 will stop logging M5T within the
OC/GUI log.

NOTICE:  If stacktracepath configured, the log with still be
collected (even with m5tdebugtrace = 0).

To completely disable M5T logs:

• Set the value of m5tdebugtrace to 0 (or deleted)
• The stacktracepath key should be deleted.

WARNING:  Activating the M5T trace will slow down the system. Only
activate this trace if the GVS or development team requests it.

Additionally, disable the M5T trace as soon as the requested traces are
collected.

3.9.8 Activating WebClient Traces

These traces will collect only information related to the interface.

To collect WebClient traces, run the following command in WE
:trace=on

The execution of this command will open a new window, where the interface
information is logged.

After the test execution, copy this content of the new window, paste it into a text
editor and save it.

Finally, run the following command to stop the traces:
:trace=off

NOTICE:  The field is part of the main GUI. More precisely, the
field is located where the user enters a phone number or a name
to perform a search or DIAL.

3.9.9 Activating DLS Traces

It is recommended to activate these traces only in case of issues with the
connection between ODC and DLS or if requested by the GVS or Development
team.

To activate DLS traces, create the following keys:

DlcTraceVerbose=dword:00000001
DLCTransformTraceVerbose=dword:00000001
DLCTraceXMLContent=dword:00000001

Use the following registry keys:
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• For a 32-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\OpenScape]

• For a 64-bit system:
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Siemens\OpenScape]

3.9.10 Activating RV-Trace

The client includes the Radvision DLLs with the following compile option:
'NOLOGSUPPORT'= true. Therefore, by default it is not possible to activate the
RV-Trace.

Follow the steps below to activate and collect the RV trace:

1) Change the original DLLs from the Client, with the corresponding DLLs
with LOG support.

For DLLs log, navigate to the following path: \Misc\Trace\RV
2) Copy the INI file, located in the following path \Misc\Trace\RV

\rvtele.ini and paste it into the Windows directory (C:\WINDOWS)
3) Restart the Client.
4) A new trace file is created in the temp folder with the following file name:

namervtsp1.log.

NOTICE:  The location of the temp folder depends on the
setup of the TEMP environment variable. Typically, the temp
folder is located at: %temp%.

3.9.11 Advanced Audio Logs

If you experience audio issues, you must collect and provide Audio logs.

Audio Logs

To collect basic audio traces, you must activate the AudioTrace registry key.
Currently, there is no support for tracing USB.

To activate audio traces, follow the steps below:

• SIP Provider

64 bit: HKLM\Software\WOW6432Node\Siemens\OpenScape

32 bit: HKLM\Software\Siemens\OpenScape

Create a new DWORD (32) with “AudioTrace” set to 1.

The WAVE Traces files will be either stored in the same folder as the GUI
trace or in the %TEMP% folder.
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• HFA Provider

Regedit: HKCU\Software\Siemens\SoftOla\Trace

NOTICE:

The same folder is used for HFA, as for SIP.

Create a new DWORD (32) with “AudioTrace” set to 1.

The WAVE Traces files will be either stored in the same folder as the GUI
trace or in the %TEMP% folder.

Figure 16: AudioTrace key

The WAVE files will monitor and trace all within area marked with green. The
trace does not include Windows components, such as Windows Audio API
or USB.

Figure 17: Starting WinDbg

NOTICE:  The audio traces only provide information about audio
issues. Client traces are still needed for analysis.
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3.9.12 PSR Tool

PSR (Problem Steps Recorder) is a free Windows tool that allows for analyzing
complex or sporadic scenarios.

The PSR tool is part of the Windows operating system 7, 8.1 and 10.

Follow the instructions below to record and save steps on your computer:

1) To open Steps Recorder, click the Windows Start button, then select:

Windows Accessories > Steps Recorder (in Windows 10),

or

Accessories > Problem Steps Recorder (in Windows 7 or Windows 8.1).
2) Click Start Record.
3) Reproduce the problem that you are trying to diagnose.

You can pause and resume the recording at any time.
4) Optionally, during recording, you can click Add Comment, then use your

mouse to select the part of the screen that you want to comment on. Type
your comment and then click OK.

5) Finally, click Stop Record.
6) Review the recording, then click Save, choose a name for the ZIP file and

the location where you want to save it. Click Save.

Attach the ZIP file and send it to the support team that troubleshoots the
problem on your PC. The recording can be displayed in any browser .

Follow the instructions below to adjust the settings of the PSR tool:

1) Open Steps Recorder and click the down arrow next to the Help button.
Select Settings.
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2) You can change the following settings:

• Output location: adjust this setting if you do not want to be prompted for
a location and file name every time you save a file. F

or this, select Browse to set a default location and file name.
• Enable screen capture: select No if you do not want to capture screen

shots (for example, if your screen displays personal information that you
do not want to share.

The app will still record a text description of your steps.
• Number of recent screen captures to store: the default number is 25

screen shots.

Increase this number if you want to record more screen shots.

3.10 Memory DUMPs

3.10.1 Situations that require memory dumps

In case of crashes (e.g. "Unify.OpenScape.exe stopped working"), dump logs
should be collected with the error window or message still displayed. You can
close the error window or message once the dump logs are collected.

If the UI is hanging (e.g. UI stops or becomes unresponsive), the dump logs
should be collected while the problem is happening, since the application might
recover without any user action.

IMPORTANT:  The DUMP file MUST be collect as 32 bit, not as
64 bit.

Examples of invalid and valid dump files:
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These details can be viewed once you open the dump file.

If the Unify.OpenScape.exe process memory consumption
increases a lot, dump files should be collected more than once.
The following steps should be performed in case of high memory
usage:

1) Collect a DUMP file just after the application is up and
running.

2) Collect additional DUMP files of 200MB-300MB each.
3) Send the files to GVS or Dev teams for further analyze.

Therefore, even if you are using Windows on 64 bits, you must use the 32-bit
Task Manager, because the OpenScape (ODC-PE) processes run on 32 bit
(except for the TSP module).

NOTICE:

If you can not successfully collect the DUMP in 32-bit format,
collect it via WinDBG as explained within chapter 5.3 or Annex
A.

The following chapters contain information on how to collect
dump logs using Windows Task Manager and WinDBG.

3.10.2 Collecting DUMPs via Windows Task Manager (32 bit)

The fastest way to collect DUMPs is via Windows Task Manager (32 bit).

WARNING:  If you are using Windows on 64 bits, you must use the 32-
bit Task Manager located in the following path:

C:\Windows\SysWOW64\taskmgr.exe

If you are using Windows on 32 bits, then the default Task Manager will
be used.
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1) Open Windows Task Manager (32 bit).

NOTICE:

In case your operating system is Windows on 64 bits, you
need to open the Task Manager on 32 bits. To do so, press
simultaneously the CTRL+SHIFT+ESC keys.

• Open an Explorer Window.
• Navigate to the following path: C:\Windows\SysWOW64.
• Double click on the TaskMgr.exe file.

Figure 18: Running TaskMgr.exe
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2) Select the desired process to collect the DUMPs:

In Task Manager (32 bit), locate the desired process for which you want to
collect a Dump file.

For example, in case the ODC-PE Client freezes, navigate to the Processes
tab and right click on the corresponding process and select Create Dump
File.

Figure 19: Collecting a Dump file

Wait for the Dump file to be collected.

When ready, a message is displayed containing the Dump file location.

Figure 20: Dump file location

Navigate to the folder with the Dump file, copy and attach it to the
corresponding PRB ticket, along with the PE logs.
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Figure 21: Collected Dump file

E.g. C:\Users\op0302\AppData\Local\Temp
\Unify.OpenScape.DMP

3.10.3 Collecting DUMPs via WinDbg

This chapter describes an overview of collecting Dump files using WinDbg.

NOTICE:  If you are using WinDbg for the first time, navigate to
Annex A for more detailed instructions.

You can use WinDbg to collect DUMP 32bit files. This tool is especially useful
in scenarios where ODC-PE chases during the start-up or when it crashes and
kills its own process. Using WinDbg, you can activate and collect DUMPs via
the command line.

Collecting logs with WinDbg is more complicated than collecting then via Task
Manager. It is not installed by default on the Windows operating systems,
therefore, it must be first installed. After the installation, you must identify the
process ID or name and use commands to complete the DUMP collection.

If you are already familiar with WinDbg, follow the instructions below to collect
Dump files:

1) If not installed yet, install the "Debugging Tools for Windows (x86)".

You must use the x86 version even if your operating system is on 64 bits.
2) Start the PE Client and wait for it to completely load.
3) Start the WinDbg tool as an administrator.
4) Attach the process you are interested in by clicking on File -> Attach to a

Process, then selecting the "Unify.OpenScape.exe" process.
5) This will stop the ODC-PE Client. To resume it, click on Debug -> Go.
6) Perform the scenario you want to reproduce: initiate an incoming call,

answer it and wait for at least 5 seconds, but not more than 10 seconds.
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7) Navigate back to WinDbg and click on Debug -> Break. This will stop the
ODC-PE Client again.

8) On the command bar (displayed in the bottom area), type ".dump /ma
<dump file>" (e.g. dump file: "C:\odc.dump ").

9) Wait for the write operation to complete.
10) Resume the ODC-PE Client (as described at step 5) and close WinDbg.
11) Provide the dump file (approximate size: 400MB to ~1GB) for further

analyze.

In case of errors during ODC-PE start process (or too fast), you can start the
PEClient via WinDbg:

1) If not installed yet, install the "Debugging Tools for Windows (x86)".

You must use the x86 version even if your operating system is on 64 bits.
2) Start WinDbg as an administrator.
3) Start the Fusion Client via WinDbg, by clicking on "File -> Open Executable

" and entering the "Unify.OpenScape.exe " process.
4) Perform the scenario you want to reproduce: initiate an incoming call,

answer it and wait for at least 5 seconds, but not more than 10 seconds.
5) Navigate back to WinDbg and click on Debug -> Break. This will stop the

ODC-PE Client..
6) On the command bar (displayed in the bottom area), please type ".dump /

ma <dump file>" (e.g. dump file: "C:\odc.dump ")
7) Wait for the write operation to complete.
8) Resume the ODC (as described at step 5) and close WinDbg.
9) Provide the dump file (approximate size: 400MB to ~1GB) for further

analyze.

For more information about collecting DUMPs via WinDbg, see Annex A.

3.11 Appendix

3.11.1 Annex A (WinDbg)

This section describes how to collect Dump files using WinDbg. It contains
information about:

• Where to download WinDbg,
• How to install WinDbg,
• How to collect Dump files using WinDbg.

You can use WinDbg to collect DUMP 32bit files. This tool is especially useful
in scenarios where ODC-PE chases during the start-up or when it crashes and
kills its own process. Using WinDbg, you can activate and collect DUMPs via
the command line.

Collecting logs with WinDbg is more complicated than collecting then via Task
Manager. It is not installed by default on the Windows operating systems,
therefore, it must be first installed. After the installation, you must identify the
process ID or name and use commands to complete the DUMP collection.

For quick instructions about collecting DUMPs via WinDbg, see chapter
Collecting DUMPs via WinDbg  on page 36. More detailed instructions are
available below:
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1) Install Debugging Tools for Windows (x86).

NOTICE:  Please note that even on 64-bits systems, you
must install WinDbgx86 since F4O runs on 32 bits.

a) Download Debugging Tools for Windows via the Microsoft official
page:

https://developer.microsoft.com/en-us/windows/downloads/windows-sdk/

or

https://msdn.microsoft.com/en-us/windows/hardware/hh852365

NOTICE:  If it is not possible to download the tool using
the above links, use the following link that contains older
SDKs installations:

https://developer.microsoft.com/en-us/windows/
downloads/sdk-archive/

b) Click Download the installer.

When the download is ready, run the winsdksetup.exe file to install the
tool.

c) Select the desired packages to be installed.
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d) Click Download to start the package installation.
e) Once the package is successfully installed, open Windows search and

enter WeinDbg.

NOTICE:  If you are using Windows 10 newest SP or
Windows 11, continue from step 3.

f) For older SDK installation, you must follow the substeps 1.6 to 2.2. These
steps are intended for users with Windows 7, 8.1 or 10 (with old SP).

Select the Get the standalone debugging tools ( WinDbg ) as part
of Windows 8.1 SDK or open the following URL with a browser of your
choice:

https://www.microsoft.com/click/services/Redirect2.ashx?
CR_EAC=300135395
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Once the download is ready, run the sdksetup.exe file to start the
installation of WinDbg.

g) If the Debugging Tools for Windows (x86) for Windows 10 package
does not work (e.g. on several variations of Windows 7), you might need
to install the specific package for it.

Therefore, click on Get the standalone debugging tools for Windows
XP as part of Windows 7 SDK or open the following URL with a browser
of your choice:

https://www.microsoft.com/en-us/download/confirmation.aspx?id=8279

Once the download is ready, run the winsdk_web.exe file to start the
installation of WinDbg.
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2) Start the WinDbg tool.

Example 1:

Example 2:
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3) Attach the ODC process.

a) If you need a DUMP file from an already running ODC, then on WinDbg
click File -> Attach to a Process and locate the Unify.OpenScape.exe
process.

Next, select the desired process to collect the DUMP file.

Check the Noninvasive option and click OK.

Continue with step c).
b) If you need a DUMP file from before ODC starts, then on WinDbg click

File -> Open Executable and locate the Unify.OpenScape.exe process.

Click Yes in the pop-up window displayed.
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This stops the ODC Client. To resume it, click Debug -> Go.

c) Perform the scenario to reproduce the error and collect the DUMP file.
d) This steps must be followed only if step b) applies for you.

If step a) applies for you, you must skip to step e).

Once the error occurs, open WinDbg again and click on Debug -> Break.
This action will stop the ODC Client again.
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e) Type .dump /ma <dump file> in the command bar, displayed
at the bottom of the WinDbg window. For example, you can use C:
\odc.dumpas "dump file".

f) Wait for the write operation to be complete. Depending on the size of
the DUMP file, this action might take several minutes.

g) Once the write operation is completed, the message Dump successfully
written is displayed. Next, close both ODC Client and WinDbg.
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h) Provide the Dump file collected to GVS for further analysis.

The size of the Dump file is around 450 MB, as displayed in the example
below.

NOTICE:  Please note that the folder with the Dump file is
the one defined in step e).

3.11.2 Annex B (perfmon)

This section describes how to collect logs using MS Performance Monitor.
These logs might be necessary for further analyzing the operating system
(Windows) behaviour and the status of specific applications.

Follow the steps below to collect logs with MS Performance Monitor:

1) Click the Windows Start button and search for perfmon. Select
perfmon.exe.
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2) Create a new Data Collector Set by navigating to Data Collector Sets
\ User Defined in the left hand panel. Right click on User Defined, then
select New \ Data Collector Set from the context menu.

3) Enter a custom name for the Data Collector Set in the Name field, then

click Next.
4) Select Create Data Logs, then check the following option: Performance

counter, Event trace data, System configuration information. Click Next.
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5) Click Add.

6) Add the following counters:

• Process - <All instances>
• Processor - <All instances>
• Memory

In the Added counters panel, you should now see:

7) Click OK, then click Finish, to create the data set.
8) Before running the data set, right click on it, select Properties. Set the

desired output location on the Directory, and click OK.
9) You can now start or stop the logs by selecting the data set and clicking the

play/ stop buttons on the menu bar.

3.11.3 Annex C (TSP logs)

This section describes how to collect TSP traces on Windows 7 and higher
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1) Activate the regedit key that corresponds to the PBX used:

• For H3K (or HP2K, OSO, or any other PBX except for the HP4K
family):

Create the Registry value DBGTrace"=dword:00000001 in the following
registry key:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\optiClientTSP
 Hicom 150\Trace]

If requested by GVS or Dev teams, add the following registry:
Value "DBGTraceEnh"=dword:00000001 in the same
 registry key.

• For H4K:

Create the Registry – Value "DBGTrace"=dword:00000001 in the
following registry key:
[HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\optiClientTSP
 HiPath 4000 V2\Trace]

If requested by GVS or Dev teams, add the following registry:
Value "DBGTraceEnh"=dword:00000001in the same registry
 key.

To activate the trace you must restart the telephony service or, if it is not
possible, restart the pc.

2) Check if the Telephony service is up and running:

• Open Windows Services: Windows Start - Run… - services.msc
• Check if the Telephony service is running.
• Ensure the path to the executable is

C:\Windows\System32\svchost.exe -k NetworkService

Figure 22: Windows Telephony service
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3) Identify the specific svchost.exe process with the Telephony service on it
in one of the following ways:

• Via Windows Task Manager (recommended)

Open Window Task Manager.

Select to show process from all Users.

Figure 23: Windows Task Manager

Select to show the PID and Command Line.

Check the PID from process with same Command Line as the Telephony
service:

Figure 24: Windows Task Manager (All Users)
• Via the Microsoft specific Tool (Process Explorer):

A31003-G2570-M100-02-76A9, 09/2024
OpenScape Personal Edition, Trace Guide, Administrator Guide 49



Traces required

a) Start the Process Explorer:

http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx
b) Hover over all svchost processes.

This action must be performed until the correct PID is identified.

The correct PID is the one that has the telephony service Telephony
(TapiSrv) under it. For example, the PID in the following figure is
1172.
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4) Select a tool to collect the traces, such DbgVieworWinDbg.

a) When using DbgView:

• Open DbgView as an administrator.
• Under the Edit menu, select Filter/Highlight...

Figure 25: DebugView – Edit menu
• Enter the Process ID.

The example below displays the Process ID from the example
presented above (Process ID 928).

Figure 26: Explorer Process ID
• Activate the CaptureGlobalWin32 option.

NOTICE:  If possible, activate also Capture Kernel.
This option might be disabled or it might be unavailable
due to operating system policies.
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Figure 27: Activating "CaptureGlobalWin32" option
• If already connected (monitoring) to the local PC, the PE3 (local)

option will be displayed inside the Computer menu:

Figure 28: Connected to local PC option (example)
• If not already connected, then the option Local PC will be displayed

inside the Computer menu. Click this option to connect to the local
PC.

Figure 29: Select and connecting to local PC option (example)
• After performing the test, select a name for the log file and save it via

the File menu, by selecting Save or Save As.
• Choose where to save the DUMP file via ProcessCrashDump option,

displayed under the File menu.
• Select the folder where you want to store the DUMP file.
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Figure 30: Selecting the Folder/file to save DUMP (example)
b) When using the WinDbg application:

• Open WinDbg 64 bit as an administrator.
• Attach the process to be monitored by WinDbg, by selecting the

Attach to a Process… option, displayed under the File menu.

Figure 31: Attaching Process (example)
• Select the desired process you want to attach from the list of

processes.
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Figure 32: Selecting the Process (example)
• Run the following command in the WinDbg command line: sxe *
• Run the following command in the WinDbg command line: g

The output of the above two commands should be similar to the one
displayed in the figure below:

Figure 33: WinDbg Debug running window (example)

In case of HP4K traces, there will be many lines with the OPTIH4V2
header.

In case of H3K or OpenScape Office traces, there will be many lines
with the OPTI_150 header.

• Perform the test, then break the process.
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Figure 34: WinDbg – Breaking process AFTER tests performed
(example)

• Save the trace by selecting the Write Window Text to File… option
from the Edit menu.

Figure 35: WinDbg – Saving log (example)
• Finally, detach the process by selecting the Detach Debuggee option

from the Debug menu.
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Figure 36:

NOTICE:  This action is very important, otherwise the
system will be unstable, because the svchost process
has several other services under it.

3.11.4 Annex D (Performance Monitor)

This section describes how to collect logs using MS Performance Monitor.
These logs might be requested by Microsoft or the Dev team to further analyze
the behaviour of the operating system or the status of a specific tool.

Follow the steps below to generate a log via MS Performance Monitor:

1) Click the Windows Start button, type perfmon and click perfmon.exe.
2) Create a new Data Collector Set by navigating to Data Collector Sets

\User Defined in the left hand panel, right clicking on User Defined, then
selecting New\Data Collector Set from the context menu.

Figure 37: Perfmon – Creating new Data Collector Set
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3) Enter a name for the Data Collector Set in the Name field and select the
Create manually (Advanced). Finally, click Next.

Figure 38: Perfmon – entering a Name
4) Click Create data logs, then enable the Performance counter, Event trace

data and System configuration information options and click Next .

Figure 39: Perfmon – Selecting Data logs types
5) Click Add.

Figure 40: Perfmon – Adding performance counters stepA
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6) Add the following counters:

• Process - <All instances>
• Processor - <All instances>
• Memory

In the Added counters panel, you can view the counters added:

Figure 41: Perfmon – Adding performance counters stepB
7) Click OK and Finish to create the data set.
8) Before running the data set, right click on it, select Properties, and set the

desired output location on the Directory, and click OK.
9) You can start or stop the logs by selecting the corresponding data set and

the clicking the play/stop buttons on the menu bar.

Figure 42: Perfmon – Start/Stop logs
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